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New features in FAstFax 3.0

For people already using FAstFax, here’s what’s new:

FAstFax 2.0 required the identifiers “To” and “Fax” each followed by a ":" to find the 
recipient’s name and fax number. With FAstFax 3.0, you can now create any custom 
identifiers you wish! For example, if you prefer “Fax #:”, or “Fax No.:”, or “Fax 
Number:”, etc., simply run the new setup program, and make the identifiers anything 
you want.

New Thumbnail Page Previewer that shows your page against a shaded background. 
Looks beautiful, and, is far superior to the old one.

For office users who need to dial a prefix number (like 9) to get an outside line, or 
people who need to dial long distance codes, or Lawyers who must enter billing codes 
before each call, FAstFax 3.0 now offers another time-saving feature. You now have 
the option to default the insertion point in any field you choose—so that you can quickly 
enter the required codes, and be on your way! Plus, you can also add commas for 
those PBX systems that require a few seconds delay.

For people who mostly fax 1 page faxes, you now have the option to default the page 
range to "current page"—so you can continue to take advantage of FAstFax's 2 
keystroke action.

FAstFax 2.0 did not work in Word table cells. FAstFax 3.0 now works with any 
combination of table cells you choose!

What is FAstFax?

FAstFax is a utility that makes faxing with Microsoft Word for Windows 6 and Delrina 
WinFax PRO 3 (and WinFax PRO for Networks) lightning fast by cutting 17+ keystrokes
down to 2.

Here’s how:

1) FAstFax scans your document, finds the recipient’s name and fax number, and 
(using DDE) automatically passes this information over to WinFax PRO—so you
no longer have to enter and maintain TWO separate phonebooks. If you’re tired 



of typing a person’s name and fax number TWICE—once on the document and 
again in the WinFax Phonebook—you will love FAstFax.

2) FAstFax gives you a thumbnail page preview of your document—so you’ll always 
fax the correct pages and be able to check the final look and layout of your fax 
before letting that puppy fly.

3) FAstFax allows you to easily fax an entire document or just the current page—
which is great for those quick 1 page faxes.

4) FAstFax automatically sets the fax driver and resets the printer driver for you—so 
you don’t have to think about driver settings again. And no more print jobs 
accidentally sent to the fax modem!

5) FAstFax does all this in 2 keystrokes!

Before the creation of FAstFax, here’s how many keystrokes it took (and, incredibly, 
this was when the person’s name and fax number was already in your WinFax 
phonebook!):

1. Hit alt-file-print.
2. Hit the “printer” button to open the “printer setup” dialog box.
3. Select the WinFax driver.
4. Hit “Set as default printer.”
5. Hit OK.
6. Set the “page range.”
7. Hit OK.
8. In the WinFax phonebook, hit the “search” button.
9. Type the person’s name.
10.Hit OK.
11.Click on the person’s name in the phone list to get his name and fax number

into the “To” and “Fax” fields. (Or, if the person isn’t already in your 
WinFax phonebook, manually type this information in.)

12.Click “send.”
13.Hit alt-file-print.
14.Hit the “printer” button to open the “printer setup” dialog box.
15.Select your printer driver.
16.Hit “Set as default printer.”
17.Hit OK.

Now, the steps with FAstFax...
1. Hit Alt-X and ENTER.
2. Go get a doughnut.

In fact, once you try FAstFax and see how much easier and faster it is, you’ll never 
want to fax the old way again.

Check out FAstFax now
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Let’s say you wanted to fax this FAstFax User’s Guide to Woody Allen at 555-555-
5555. As long as your fax contains:

To: Woody Allen
Fax: 555-555-5555

anywhere in it, FAstFax will automatically grab the name and fax number and pass it 
over to WinFax PRO.

Check it out now. Simply hit Alt-X and FAstFax will appear with the name and fax 
number fields already filled in. Play with FAstFax’s page preview. And notice how the 
page range is automatically filled in for you every time you change pages in the 
thumbnail page preview or switch between "All Pages" and "Current Page." When 
you’re done checking it out, hit CANCEL (rather than ENTER) to avoid actually faxing 
the Wood-man.

Installation and Setup

To setup FAstFax, DOUBLE CLICK the "install button." The FAstFax 
Setup dialog box will appear. You can then pick the default settings of 
your choice, and create your own custom identifiers.

Note: This setup is made to be run again and again, anytime you wish to choose 
different default settings or re-design your own custom identifiers.

Note: For FAstFax to install properly, all three files (FASTFAX.DOC, FASTFAX.DOT, 
and FASTFAX.BMP) must be in the same directory (for example C:\FASTFAX). This is 
because the install macro looks for FASTFAX.DOT and FASTFAX.BMP in the same 
directory that you open FASTFAX.DOC.

We recommend you create a directory called C:\FASTFAX to store all the FAstFax files.
This way you can re-run the Install FAstFax macro any time in the future should you 
decide to change any of the defaults or re-design your own custom identifiers.

This is what the install macro does:
· It copies the FAstFax macro into your NORMAL.DOT template so that it will be 

available globally.
· It assigns the keyboard shortcut key of Alt-X to the FAstFax macro.
· It adds FAstFax to the bottom of your Tools menu.
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FAstFax Identifiers: “To:” & “Fax:” or Whatever you want!

FAstFax searches for “To:” and “Fax:” (or any custom identifiers you create) to identify 
the recipient’s name and fax number. If FAstFax can’t find a “To:”, it will put you in the 
To: field and wait for you to enter the recipient’s name manually. If FAstFax can’t find a 
“Fax:”, it will put you in the Fax: field and wait for you to enter the fax number manually.

Because FAstFax scans the entire document, the “To:” and “Fax:” information can be 
anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a
one page letter, they will be on that. But the nice thing about FAstFax is that they don’t 
have to be. They can be anywhere.

Note: FAstFax always goes to the top of the document and searches down. So if 
you save many faxes in one file, order them the way you file paper files—i.e. the most 
recent first. This way FAstFax will always find the correct “To:” and “Fax:”.

The Big Tip: "Hidden Identifiers"

FAstFax's ability to find "hidden identifiers" gives you complete flexibility in designing 
your faxes to look exactly the way you want, while at the same time allowing FAstFax to
find the recipient's name and fax number accurately. To understand how this works, 
please see the following 3 examples:

Example 1: Hiding the "To:" and/or "Fax:"

If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden
identifiers” by selecting them and choosing Format>Font>Hidden text. FAstFax will still 
find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your 
fax.

For example, you might want to fax a one page letter containing the recipient’s name, 
address, and fax number—but in this case, you wouldn’t want the word “To:” to show 
up. Simply do it like this:

Jay Bonzi
396 17th St.
Paso Robles, CA  93446
Fax: 805-238-5798

Dear Jay,

I love FAstFax! Great work! Kudos!

(Note: there is a hidden “To:” before the name Jay Bonzi. If you cannot see this, hit 
Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and know 
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it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when you 
print and/or fax.)

Example 2: Using Separate Cells

If you split “To:” and "Woody Allen" into separate cells, FAstFax has no way of knowing 
they are related.

To: Woody Allen

But not to worry! If you prefer this two-cell method, you can easily make it work with 
hidden identifiers! Simply custom design a name identifier (into anything different than 
"To:". For example, I use "To>"). Then simply add that "To>" as a hidden identifier. Like
this:

To:  Woody Allen

FAstFax will search for "To>" and find Woody Allen! (Notice, too, that my hidden 
identifier "To>" is in a tiny 8 point font so that it is nearly unnoticeable on the screen.)

If you use this method often, I recommend that you store the hidden identifiers "To>" 
and "Fax>" in Word's AutoCorrect (with "formatted text"). Then all you have to do is hit 
"t" space, and AutoCorrect will replace the "t" with the hidden "To>". Then simply type 
the recipient's name like you always do.

Or, here's an even better idea! Just put the hidden identifiers in your fax templates. 
Then, every new fax document you create will already have them typed in.

Example 3: Skipping over YOUR fax number

If you have a header with YOUR fax number in it, you will want FAstFax to skip over 
your fax number and find the recipient’s fax number. You could simply make your fax 
number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want
to use the same identifier for both your fax number and the recipient’s fax number, you 
can simply use a hidden identifier (like "Fax>"). Example:

ABC Widget Co.
1225 Main St., Paso Robles, CA  93446

Phone: (805) 222-2222  Fax: (805) 444-4444

To: So-and-so.
Fax:  555-555-5555

Dear So-and-so,

I love your widgets! Great work! Kudos!
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Or, another way is to simply add a hidden space between "Fax" and the ":" in your 
letterhead. FAstFax will then skip over your fax number and find the recipient's fax 
number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax 
number identifier will look like this: "Fax:". But that hidden space won't print, so on the 
fax, it will look like this: "Fax:".

So you see, with FAstFax 3.0, you have complete flexibility in designing your faxes to 
look exactly the way you want, while at the same time allowing FAstFax to find the 
recipient's name and fax number accurately.

Suggestions

The most efficient way to use WinFax PRO and FAstFax is to have WinFax PRO 
already loaded, because this way, when you run FAstFax, it will pop right up. But even 
if WinFax PRO is not already loaded, it's no big deal. It only adds one more keystroke.

When you run FAstFax without WinFax PRO already loaded, the following message 
appears: “The remote data (control) is not accessible. Do you want to start the 
application FAXMNG?” FAXMNG is the main WinFax PRO program (it stands for “Fax 
Manager”). This message is Delrina's way of saying, "Do you want to load WinFax 
PRO?" So simply hit "Yes"—it will quickly load WinFax PRO—and FAstFax will take it 
from there.

If you’re a person who enjoys Delrina’s preview/annotate feature, FAstFax supports 
this. Simply set the “preview/annotate” feature to on, and FAstFax will allow you to 
preview/annotate prior to faxing.

If you’re a toolbar person, assign FAstFax to a toolbar button. The only reason we 
didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t 
have any more room to add toolbar buttons.

Registration

FAstFax 3.0 is Shareware. You are encouraged to use this program for 30 days prior to
obtaining a permanent license.

If you use FAstFax regularly, it should save you a great deal of time and trouble. For 
this we ask just $20.

You’ll notice that every feature in FAstFax is fully functional; nothing is disabled or 
“crippled”; and there are no registration warnings, naggings, or threats. We believe true 
Shareware is based on the principle of honesty. So we give you a fully functional 
version of our program, and simply trust you to register it if you find it of value and 
continue to use it.
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Registered users of FAstFax 2.0 can upgrade to FAstFax 3.0 for free. It costs you 
absolutely nothing. This is our way of saying "Thank you!" for your ideas, feedback, and
support.

Unregistered users of FAstFax can register by sending a check or money order for the 
total number of copies you wish to register to:

Jay Bonzi
396 17th Street
Paso Robles, CA  93446

Or you can register quickly by Fax or E-mail, with a charge card (Visa, MasterCard, or 
Discover). Simply include the name as it appears on the card, type of card (Visa, 
MasterCard, or Discover), the card number, and expiration date. Send to either:

Jay Bonzi, Fax: (805) 238-5798
Jay Bonzi, CompuServe: 72053,2227

I will send you a personal registration number, along with any other timely information 
regarding FAstFax. I will also enter you into our database of registered users, so that 
we can notify you immediately of future versions and updates. I'll also tell you about any
new FAstFax features we are in the process of adding to the program. (For example, 
we’re now developing the following: mail-merge group faxing, date and time scheduling,
automated cover sheets, date & time stamps, and file attachments. Of those, we're 
most excited about the mail-merge group faxing. The ability to do personalized group 
faxing is going to be truly awesome.) So whichever way you decide to register, be sure 
to include your fax number, E-mail address, or regular mail address—and we’ll notify 
you the minute FAstFax 4.0 is ready!

Also, give us your suggestions and ideas! Joe and I are proud of FAstFax. And what we
love most is the process of making it slicker. That’s where all the fun is. So send us 
your suggestions and ideas!

Other FAst Programs

Also, let us know if one of our other programs sounds like something you might be 
interested in, and we’ll notify you when they’re finished:

FAstDial
Much like FAstFax, FAstDial will scan any Microsoft Word document and use your 
modem to dial whichever telephone number you desire.

FAstPage
When you are away from the home or office, and someone leaves a message on your 
answering machine, FAstPage will immediately call your cellular phone or pager and let
you know—so you no longer have to call your machine every few hours to check your 
messages. You’ll always know immediately when someone is trying to reach you.
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Turns your cellular phone into a pager—at no additional cost (because it only rings 
once, and as long as you don’t answer it, you get charged nothing.)

You can use it every time you go out, or just when you’re expecting Steven Spielberg to
call.

If you have any questions at all...

Hi. This is Joe. Feel free to fax me at 805-239-5670 any time, day or night. (Note: 
That's my home computer. And I work from 9:00am - 6:00pm Pacific time, so I’ll be able
to fax you back that evening, or early the next morning. No matter what, I promise I’ll 
get back to you within 24 hrs.)

Hi. This is Jay. If you have any questions at all, feel free to fax me at 805-238-5798 any
time, day or night. (That's my home computer also. So I’m able to reply before work 
(9:30am), or after work (5:30pm), or oftentimes, even during the day (because I often 
work at home).) Or you can E-mail me on CompuServe at 72053,2227. I check my E-
mailbox frequently, and if you're having problems, I'll get right back to you!

Closing Statements

Hope you enjoy FAstFax!

Don’t eat too many doughnuts...

* * * * * * * * * * End of FAstFax User’s Guide * * * * * * * * * *
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* * * * * License Agreement * * * * *

You are encouraged to use this program for 30 days prior to obtaining a permanent license. You may 
share the files FASTFAX.DOC, FASTFAX.DOT, and FASTFAX.BMP with anyone you choose as long as
you do not change them. You may not share the registration key, which is supplied to licensed users 
only. If you choose to continue using the program and register, that registration key may be used only by 
the licensee specified in the original order for the license. Licenses are not transferable and may not be 
modified. A single License permits you to use one copy of the FAstFax software on any single computer, 
provided the FAstFax software is in use on only one computer at any time. If you have multiple Licenses 
for FAstFax, then at any time you may have as many copies of FAstFax in use as you have Licenses.

It is your responsibility to determine if the program will work reliably on your equipment and for your 
particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO 
THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER 
BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL 
RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow 
the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may 
not apply to you.

This agreement shall be governed by the laws of the State of California and shall inure to the benefit of 
BONZI SoftWare and any successors, administrators, heirs and assigns. Any action or proceeding 
brought by either party against the other arising out of or related to this agreement shall be brought only 
in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, 
California. The parties hereby consent to in personam jurisdiction of said courts.

* * * * * Acknowlegements - Trademarks * * * * *

WORD FOR WINDOWS and Microsoft are registered trademarks of Microsoft Corporation.

WINFAX PRO and Delrina are trademarks of Delrina Technology Inc.

Other brands and product names mentioned in this manual are trademarks/ tradenames of their 
respective owners.
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